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Lab Assignment #12: Assemblies & Mechanisms ME170 

Instructor: Mike Philpott (email: mphilpot@illinois.edu) 

Date Due: One week from Start Day of Lab (turn in deadline – 11pm night before next lab) 

 

Part 0. Configure Creo. 

Apply the 'config.pro' file in your working directory as in Part I of Lab 8. 

 

Part I a. Complete Exercise 18 (pg 409-427) 

You will assemble your electronic dongle in this exercise. 

Task 1 

- Uncheck "Use default template." 

- Select the "mmns_asm_design" template from the drop-down menu in the "New File 

Options" window (image below). 

 

- You do not need to read the message area. We are using a template different from the 

book's template. Your template will NOT be copied from "template_mm.asm". Do not 

add the configuration options listed on page 4. 

- Datum planes and datum tags should be displayed automatically due to parameters in the 

"config.pro" file. There is no need to adjust these. 

- The configuration option "comp_assmeble_start" is set by the "config.pro" file, which 

you applied in Part 0 of this lab. 

Task 2 

- The planes can be selected in either the model trees on the left side of the screen or in the 

main and accessory windows. It is often quicker and easier to select basic datum features 

using the model tree. 

- To see the placement constraints that you have created, click the "Placement" tab in the 

dashboard tool. Here you can add, delete, and edit placement constraints. 

Task 6 

- Click the "Preview" button. This will perform the interference computation. 
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Task 13 

- On the dongle, you should have an option to select one of two axes - one created by the 

battery's revolve, and another created by the hole in the back cover. Select the axis for the 

hole in the back cover since this is the more robust reference. 

 

Part I b. Complete Exercise 20 (pg 444-447) 

 

Assembly Drawings. 

The book uses a D-size sheet for the assembly drawing. A D-size sheets measure 36" x 24". 

Although this is a typical drawing size, we do not have access to a plotter (a large printer) to 

print drawings this large. In order to print using common printers, we will create our assembly 

drawings using the "mechse_assembly.frm" file.  

Due to the smaller sheet size, we will split our assembly drawing into two separate drawings. 

The BOM and exploded view will be on the first drawing. The orthographic view and sections 

will appear on the second drawing. Images of the final drawings are given in the appendix of this 

lab instruction sheet. 

Follow the books directions, but remember to separate the two drawings as noted in the previous 

paragraph. 

Task 1 

- Use your " mechse_assembly.frm " file as the format. Do not use the book's format! 

Task 2 

- Place the general view on the second sheet. 

- To create cross sectional views, you must start with the assembly model. With the 

“Model” ribbon selected, click Manage Views->View Manager. Select the “Sections” tab 

and click the new button. Choose a planar cross section and select the proper datum 

planes for the cross section location. The direction of the arrow will match the direction 

of the arrow in the drawing. Click the green checkmark when the arrow is in the right 

direction.  

- To add the cross section view to the drawing, right click on the projected view and click 

properties. Click on the Sections tab and select 2D cross section. The + button will add a 

new cross section. Select the cross section with a green checkmark and scroll the slider to 

the right to select the “Arrow Display”. Click inside the box and then click on the view 

you want the arrows to be displayed on.  

- Do not worry if the arrows don’t show up clearly in your pdf. Creo sometimes has trouble 

with exporting the drawing arrows. Just make sure they are reasonably scaled and in the 

right spot.  

http://www8.hp.com/us/en/large-format-printers/designjet-printers/overview.html
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Task 3 

- Place the exploded view on the left side of the first sheet. Try and have the parts move 

diagonally across the page. Similar to the sketches in lab 3. 

- To edit your explode you need to have the assembly model open. With the “Model” 

ribbon selected, click Manage Views->View Manager. Select the Explode tab and create 

a new exploded view. Right click on that view and select “Edit Position”. This will let 

you drag the parts into your desired positions. Once the parts are organized, right click 

the drawing again and select “Save”. This will update your drawing.  

- To exit the exploded view in your model, right click on the exploded view in the View 

Manager and uncheck the Explode checkbox.  

- You do not need to match the scale from the drawing in the appendix. Choose whatever 

scale works the best. 

Task 4 

- The BOM table will automatically populate with your parts and their data. If this doesn’t 

work follow the BOM Help document provided. 

- Use a balloon offset value of '0.5'. Drag the balloons into spots that make sense. Make 

sure they don’t overlap or interfere with parts. They do not need to match the example 

drawing exactly.  

- Use the drawings at the end of this lab instruction sheet as a guide instead of the book's 

drawings. 

- Complete the drawings so that they match the drawings shown at the end of this lab 

instruction sheet. Refer to the prior instructions for printing drawings as pdfs. Refer to 

the "Drawing Tips" sheet for some useful drawing creation tips. 
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Part II. Complete the Mechanism Exercise 

Creo Mechanism 

 

 

Creo Parametric isn’t just used for solid modeling. It has many plugins that can be installed to 

expand its utility. In future design classes (ME370, 371) for example, you will be using Creo’s 

“Simulate” plugin to analyze the stresses in parts you will be designing.  This lab will give you a 

general introduction to Creo’s “Mechanism” plugin. This plugin allows the user to run motion 

analysis on assemblies. Instead of using 3rd party software, an assembly can be directly imported 

into Mechanism and analyzed. Features like springs and dampers can have real life properties 

assigned to make the model as accurate as possible. Along with showing you the actual 

animation of your assembly, Creo Mechanism can output position, velocity, acceleration and 

even force data for any point in the assembly. We will just be going over the basics, but there are 

endless possibilities with a tool like this.  

Task 1 

- Download the required files from the ME170 course website. All the required files are in 

the ME170Mechanism.zip which can be found on the home page.  

Task 2 

- Open up the “Mech_Simulator.asm” model. This simple assembly has two gears and a 

cam. You will eventually add a servo motor, a force motor, a spring and a damper.  

- Use the Drag Components button and click on a gear. Once the gear is selected move 

your mouse to turn it. Notice the entire assembly is not moving.  
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Task 3 

- Click on the “Applications” tab and select “Mechanism”. This will open the assembly up 

in mechanism mode. 

 

- Notice that the model now has orange lines and arrows through parts of it. These 

correspond to motion axes. When the assembly was originally put together, it was 

constrained using Mechanism constraints that allow for motion. We will be using these 

motion axes to animate and analyze the model. 

Task 4 - Gears 

- We will start by connecting both of the gears together. With the Mechanism tab open, 

click on the “Gears” icon in the connections section. The definition window should open 

up. 

 

 

 

 

 

 

 

 

 

- Set the gear type to “Generic” and click on the white arrow to specify the motion axis. 

Select the motion axis that goes through the center axis of the yellow gear. The pitch 

circle of this gear is 50mm. This is determined during the design of the gear. 
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- Click on the “Gear 2” tab and follow the previous directions for the green gear. Select 

Okay when the “Gear 2” tab is completed.  

- Now you can click on the “Drag Components” icon and select either gear. Move your 

mouse around and notice both the gears now move with each other.  

 

 

Task 5 – Cam and Follower 

- We now need to properly constrain the cam and its follower to move with each other. The 

cam currently rotates, but it goes right through the follower as if it isn’t there. This isn’t 

how we want the model to behave, so we need to setup a cam connection.  

- Under the connections tab, select Cams.  
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- The definition window will open up with multiple tabs that need to be filled out. We will 

use the first tab to specify our cam. With the Autoselect box “Checked”, click on the 

outer surface of the Cam. Creo will automatically select the entire outside diameter when 

Autoselect is turned on. A dialog box will open up. Click “OK” in the popup to move on 

to cam 2. 

 

- We now will use the “Cam 2” tab to setup the follower. Click on the first white arrow and 

select the bottom surface of the follower. Then click OK. Now select the following two 

vertices and then click OK.  
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- Now the cam and follower will animate as expected. Click on “Drag Components” and 

drag the gears around. The cam will rotate just like before, but now the follower will 

move up and down to the outer profile of the cam.   

Task 6 – Force and Servo Motors 

- So far we have been manually moving our mechanism to see the resulting motion. This is 

convenient when checking individual connections, but not efficient for any extended 

motion.  

- We will now add motors to move the mechanism for us. The first motor that will get 

added is a servo motor. This motor moves the mechanism for a set duration of time. 

Servo motors do not take any forces into account, they just move the model. Click on the 

servo motor icon in the “Insert” tab to add one.  

 

- The definition window will open up and ask you to select a motion axis. Select the 

motion axis going through the yellow gear. Then click on the profile tab and look over 

the options.  
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- A servo motor can be setup as a positon, velocity or acceleration servo. We will be using 

a constant velocity servo with a magnitude (A=30).  

- Once these settings are set, click OK. 

- We also want to add a force motor. For an analysis that requires forces to be taken into 

account, a force motor is required. This motor will output an actual force/torque and try 

to move the assembly. If the force/torque isn’t enough, nothing will happen, unlike when 

using a normal servo motor.  

 

- To add a force motor, click on the “Force Motors” icon on the insert tab. Select the same 

motion axis as the servo motor (the yellow gear motion axis). For this analysis, we will 

set a constant force with A = 1. Click OK when finished.  
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- The resulting animation from these motors will be seen during the analysis tasks.  

Task 7 – Springs and Dampers 

- We can now add a spring and damper to the model to impede the cam’s motion and 

change the system dynamics.  

 

- To add a spring, click on the “Springs” icon on the “Insert” tab. Make sure you turn on 

Point Display to show datum points. Select the point labeled “Top” and then hold CTRL 

and select the point labeled “Bottom”. Your spring should now appear inside of the 

follower part.  

- Click on the “Options” tab and select “Adjust Icon Diameter”. Set this to 17 to have Creo 

draw the spring on the outside of the follower. 

- Set the units to N/m and the K value to “.5”. 
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- To add a damper, click on the “Dampers” icon located right below the “Springs” icon and 

follow the same directions once again using the “Top” and “Bottom” datum points.  

- Set the C value to “.5” and the units to N sec/m.   

Task 8 – Analysis 

- Now that everything is properly setup and constrained, we can analyze the model.  

- Click on the “Mechanism Analysis” button located on the Analysis tab.  

 

- The analysis definition window will open up. This is the window that is used to run the 

different types of analysis. We will be choosing between position, kinematic(velocity, 

acceleration) and dynamic(force). Make sure to name your analysis at the top of this 

definition window. 

- The preferences tab is used to setup our analysis duration. For the position and kinematic 

analysis set the end time to 20 and the frame rate to 100. This will give us a lot of data 

points to smooth the graphs out.  

- Make sure to run both a Position and a Kinematic analysis before moving on to the 

Dynamic analysis. 

- If your assembly animation becomes unstable and no longer looks to be correctly 

constrained after an animation simply regenerate the model and it will revert to its 

original position. This can be accomplished by clicking the Regenerate button under the 

Model ribbon. 
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- The “Motors” tab is used to specify which motors will run the analysis. For the position 

and kinematic analysis, only the servo motor will be listed. Once the motors are setup, go 

back to the preferences page and click “Run”. The model will animate until the duration 

expires.  
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- A dynamic analysis has a few settings changed.  

- In the preferences tab, set the duration to .5 and the frame rate to 5000. The motor is 

setup to have a high enough force that we will get enough rotations in .5 seconds. A 

frame rate of 5000 will give us a large number of data points to smooth out the graphs.  

- A dynamic analysis can include force motors, so both the servo and force motor will be 

listed on the motors tab. You will need to delete the servo motor during the dynamic 

analysis we are using. Use the buttons to the right of the motors to add or delete motors.  
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- Once again, make sure to name your analysis and then click run. You should see your 

model animate again.  

Task 8 – Measures 

- After running the analysis, plots can be created from the results. This is done by clicking 

the “Measures” icon located in the analysis tab.  

 

 

- The first thing to notice is that the results from the analysis are shown towards the button 

of the Measures window. You can create a measurement variable and choose from these 

sets of data to make your plot.  

 

- Measurement variables are made by clicking the white paper under the “Measures” label. 
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- Name your measurement and select its type. A position analysis will display position 

data. Kinematic analysis will display velocity and acceleration. Finally, dynamic will 

display all three.  

- After selecting the type, click the white arrow to select the point or motion axis to 

measure. An intuitive point to measure would be the “Bottom” or “Top” datum points 

located on the cam follower.  The example plots at the end of this manual are from the 

“Bottom” datum point.  

 

- Once your measurement is created, select it and then select the “Result Set” that you want 

to plot from. If the measurement and results are a valid combination, the graph icon at the 

top of the window will become clickable. Click it to plot your data.  



Lab Assignment #12  ME 170 

  Page 16 of 21 

 

 

 

 

Part III. Homework Submission Requirements 

From Part I a. and b. Assemblies  

1) Create a zip file named " <netid>_lab12.zip" with the following files. Submit it for grading 

through the my.mechse website. Be sure to include the latest version of the assembly AND 

the latest version of each associated part file. 

netid_4455-010.asm.# 

netid_4455-###.prt.# (ALL the referenced part files in the assembly) 

netid_4455-010_assembly.drw  

netid_4455-010_assembly.pdf 

 

2) Test your assembly submission. Close and reopen Creo. Set you working directory to your 

Lab 12 submission folder. Open your assembly file. Ensure that the file opens without error. 

Look at the parts within the assembly. Ensure that they "look" correct. Check for 

interferences. If all is good, submit your zip folder to the my.mechse website. 
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From Part II – Mechanisms 

- Run a kinematic analysis on the system using the specified durations provided earlier in 

the lab manual. Turn in a graph for position, velocity and acceleration for the 

“BOTTOM” datum point located on the follower. You should use only the Kinematic 

result set. 

- Run a dynamic analysis on the system and turn in a plot of the position of the “Bottom” 

datum point of the follower. This analysis should be run with the spring, damper and 

duration values from earlier in the lab manual.  

- Run another dynamic analysis on the system, but change the spring constant from .5 to 1.  

- Your plots do not need to look exactly the same as the plots at the end of this manual. All 

we are looking for is plots that are similar in shape with roughly the same period, min and 

max values. Do not worry about matching exactly what is at the end of the lab. 

- You can use the Snipping Tool to save the plots as .jpg files. The snipping tool is found 

on every Windows computer in EWS labs.  

- Export one of your analysis animations to be turned in.  

o Click on the Playback button located next to the Mechanism Analysis button. 

 

o Select your “Result Set”. If it isn’t listed in the dropdown click the folder icon and 

open the result. Results are saved in your working directory.  

o Click the “Play Current Result Set” button located to the left of the folder icon to 

open the playback screen. 
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o Turn the speed to maximum speed and click play to watch your animation. If it is 

too slow, change the “End Time” or “Frame Rate” options and rerun your 

analysis. 

o Finally, click capture and click Okay. Creo will start exporting your animation 

with the default settings. 

 

o The video is now located in your working directory. Verify that it works and turn 

it in. 

Submit the following files for grading through the my.mechse website. Be sure to include the 

latest version of the assembly. 

Animation.mpg 

Kinematic_position.jpg 

Kinematic_vel.jpg 

Kinematic_accel.jpg 

Dynamic_position.jpg 

Dynamic_position_highk.jpg 
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Part III. Troubleshooting Guide: 

Here are a few helpful tips to troubleshoot any issues you might encounter. 

If your dynamic plot doesn’t turn out as expected, check if you deleted the servo motor from the 

motor list. The dynamic plot should only have a force motor listed. 

Check the units on your spring and damper. They should be in units of m, not mm. Make sure to 

enter in a new value for your spring and damper constants as just changing the unit will scale the 

previously input constant. 

If your animation is not moving make sure to check the units on your spring and damper. The 

motor may not be able to overcome the spring and damper settings you have setup. 

If your model isn’t animating correctly check to see if your servo motor is set to velocity and not 

position. 
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